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Welcome to the world of nonlinear editing! This class will teach you how to use Adobe Premiere
Elements 11. This program is easy enough for the beginning user, but has the tools available to
make your project as complex as your imagination can make it. In order to pass this class you
must complete the instructor led handson training and score at least 70% on a proficiency test.
Getting Started:
In order to edit in the Fayetteville Public Access Television edit rooms, you will be required to
create a personal folder on the Media Raid 0 hard drive. We strongly suggest that you use your
own external USB drive. Your instructor can give you a recommendation about what type of hard
drive, where you can purchase it, and offer suggestions on size depending upon your planned
usage.
If you are the first person to use the edit room that day, you will need to login. You can do this by
first clicking on the “Public Access User” icon, and then entering the password “user”.

Now you are ready to
open the editing
program. The icon for
Adobe Premiere
Elements is located at
the bottom of the
screen in the dock. To
open the program click
on the icon one time.

The program
will open to a
new blank
project.
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Before you begin editing, it is important that you name
and save your project. To do this, click on the “File” tab in
the upper left area of the screen, and then click on
“Save”.
NOTES
______________________________________
______________________________________
______________________________________
______________________________________
______________________________________

You will then select a destination in
which to save your project, and
give it a name. Select your folder
on the Media Raid 0 hard drive, or
your personal external hard drive,
and name your project before
clicking on “Save”.

NOTES
________________________________________________
________________________________________________
________________________________________________
________________________________________________
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Now it is time to set the “Scratch Disks”.
To do this, you will need to click on the
“Adobe Premiere Elements 11” tab in
the upper left hand portion of the screen,
select “Preferences” and then “Scratch
Disks”.

This is the “Scratch Disks” window. It lists all of the different elements that are associated with
your project. Each element has a drop down box located in it. Please make sure that all of these
tabs say “Same as Project”. If any do not, change them at this time. You may now close the
“Scratch Disks” window by clicking on “OK”.
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Importing Assets:
Since you have now created a project, saved it,
and set the scratch disks, you are ready to start
importing your assets into your project. Assets
can be video clips, audio clips, still images or
graphics. To import your assets, you will click on
the “Add Media” tab and select the appropriate
selection from the menu. All of your assets
should be located on the Media Raid 0 hard
drive, or your external USB device, so the
appropriate selection is “Files and folders”
located at the bottom of this menu.
NOTES
_____________________________________
_____________________________________
_____________________________________
_____________________________________
_____________________________________
_____________________________________
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Now you will navigate to your folder on the Media Raid 0 hard drive, or your external USB device,
and select the asset that you would like to import into your project. When you have selected the
asset that you would like to import click the “Import” button at the bottom of the window. You can
select multiple assets at one time, or you can bring them in individually by repeating this process.

After you have imported your assets, they will
appear in your “Project Assets” bin. Each asset will
have a small logo in the upper right hand corner
indicating its file type. For example, video files will
have a “film strip” logo and audio clips will have a
logo that looks like a speaker.
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Editing:
Now you are ready to begin editing your clips and inserting them into your timeline. Select the clip
you would like to begin with by double clicking on it inside of the “Project Assets” bin. This will
open a viewer window so you can manipulate the clip.
There is a reference guide of keyboard shortcuts at the end of this handout.

The following is a list of
all of the buttons
located in the viewer
window and what they
do.
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The blue triangular object at the top of a
red line is the “Current time indicator”.
It is sometimes referred to as the
“playhead”. You can click and drag the
playhead back and forth through your
clip to find a specific point.

You can drop the entire clip into the timeline, or select In
and Out points to add a specific section of a clip.
Once you have located the point where you would like the
clip to begin click on the “Set In” button on the lower left.
Likewise, when you have located the point where you want
your clip to end, click on the “Set Out” button located on the
lower right.

Now that you have selected the starting point
and ending point for this clip, you can bring it
into your timeline. To do this, just click and
hold in the center of the viewer screen, drag
the clip down to the timeline and drop it on
the track labeled “Video 1”. If the clip contains
audio, it will show up just below the video
track on the “Audio 1” track in the timeline.
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You can continue adding clips to the timeline by repeating
the previous steps. After clips have been added to the
timeline, you can change their location and order by
clicking on them and dragging them to where you would
like them placed.

NOTES
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
Transitions:
The way in which any two video clips are joined
together is called a transition. Transitions are
very important. The most common transition is
the “Cut”, in which one clip changes instantly to
the next. The next most common transition is
the “Cross Dissolve”. Here, one clip gradually
dissolves into the next. Advanced transitions
include wipes and digital effects, where clips fly
around or do complex changes while leading
into the next clip. Transitions can be a lot of fun,
but be careful of over doing it. Over using
transitions can be distracting. To access
transitions in Adobe Premiere Elements 11
click on the “Transitions” tab located at the
bottom of the timeline.
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Once you have the transitions tab open, you will
notice a drop down menu located at the top center.
This is the category menu which allows you to
choose from all the different types of transitions.
Audio transitions are also one of the category types.

Select the transition you would like to use, then click and drag the icon for
that transition and drop it between the two clips on the timeline where you
would like the transition.
When you release the transition, you will get a popup menu that will give
you the options to adjust the transition.You can adjust the alignment and the
length of the transition. After you have made all adjustments, just click
“Done”. You can always go back later and edit or remove a transition if you
like.

NOTES
___________________________
___________________________
___________________________
___________________________
___________________________
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Titles and Text:
The “Titles & Text” tab is located next to the “Transitions” tab. Just like in Transitions, you will have
a category drop down menu where you can choose from different types of titles and text. There
are several premade templates for you to choose from. Choose the one that you think best fits
your program.

Once you have selected the template, click
and drag the icon over to the timeline and
release it where you would like the text to
appear. If you want the text to appear on top
of your video place the icon on the video
track above the video already on the timeline.
If you place your text on the Video One track
it will appear as text over a black
background.

After you have placed your text on the
timeline, you can edit it by clicking on the
“Adjustments” tab on the right side of the
screen. In this window, you can change the
font, size, color, style, spacing, and location
of the text.

NOTES
______________________________________
______________________________________
______________________________________
______________________________________
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Effects:
Next to the “Titles & Text” tab is the “Effects” tab.
Clicking on this tab will bring up the effects window
which will allow you to alter and stylize your video
clips either significantly or subtly. For example you
can adjust color intensity, adjust brightness, or even
distort your video clips. Feel free to experiment with
the different types of effects to get an idea of what
they do.
In order to apply an effect to a clip, simply click and
drag it onto that clip and release it. Most effects can
also be adjusted once you have applied them to a
clip.

NOTES
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
__________________________________________________________________________
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Saving and Sharing:

It is always a good idea to save your project
often. Just click on “File” and then “Save” (or
Cmd+S). It is recommended that you do this
anytime you feel you have made significant
changes to your project.

When you have completed your project you
need to submit it for playback on Fayetteville
Public Access Television. In the upper right
part of the screen, you will see the
“Publish+Share” button. When you click on it
another window will open showing you all the
different options available to output your
program. The most common types for
playback submission are DVD or an mpeg2
file. Other options for sharing your project
with others include uploading your project to
the internet via Facebook, YouTube, or
Vimeo.

To create a DVD, select the “Disk” option,
then follow the prompts. Be sure to load a
blank DVD first.
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To upload your video to the internet, select
the “Online” option. You will then choose
between Facebook, YouTube, or Vimeo.
Select the one you want and follow the
prompts.

Archiving:
(VERY IMPORTANT!)
When your project is complete, you are responsible for archiving your program. Make sure you
save all your output files and asset files to an external hard drive. After your project has been
saved to an external hard drive, please notify the staff that your project is complete so it can be
removed from the community drive.

NOTES
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________
______________________________________________________________________

08/2014
14 of 15

Keyboard Shortcuts:

Cmd + C

Copy

Cmd + X

Cut

Cmd + V

Paste

Cmd + Z

Undo

Cmd + Shift + Z

Redo

Cmd + A

Select All

Cmd + Shift + A

Deselect All

Spacebar

Play/Stop

Enter

Render

J, L

Rewind, Fast Forward

Left/Right Arrows

Move One Frame

+

Zoom In



Zoom Out

\

Show Entire Sequence

Home

Move to Start

End

Move to End

Page Up

Move to Next Edit

Page Down

Move to Previous Edit
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